
Порядок организации написания творческих, исследовательских и практических 

работ в Таллиннской Мустамяэской реальной гимназии 

 

Настоящий Порядок регулирует организацию написания творческих, исследовательских и 

практических работ в Таллиннской Мустамяэской реальной гимназии. 

 

 

1. Основные положения  

 

1.1. Согласно Школьной программе обучения ТМРГ учащиеся 8-го класса обязаны 

выполнить творческую работу, которая является одним из обязательных условий 

окончания основной школы. 

1.2. Согласно Школьной программе обучения ТМРГ учащиеся 11-го класса обязаны 

написать исследовательскую работу или выполнить практическую работу, что является 

одним из обязательных условий окончания гимназии. 

1.3. Ученическое исследование – это письменная работа, подготовленная учеником в 

рамках учебной программы. Исследование обосновывает выбор проблемы, даёт обзор о 

происхождении поставленных вопросов, отражает выбор методов, данные и сбор 

доказательств, описывает результаты и представляет их анализ, выводы и заключение, 

перечень использованной литературы и резюме на двух языках. Ученическое 

исследование – это оригинальная, обьективная и системная работа с доказательными, 

смысловыми и ясными результатами.  

1.4. Практическая работа – это работа в виде произведения, ученической фирмы, 

технологического решения, учебного материала или проекта, созданная учеником  в 

рамках учебной программы. Письменный вывод работы показывает подоснову 

практической работы, исходные задания и цели, а также описывает концептуальное 

решение, актуальность работы, процесс и её результат. 

1.5. Вышеуказанные работы оформляются согласно Положению об оформлении 

исследовательских и практических работ ТМРГ и представляются руководителю работы, 

рецензенту и /или другим лицам, задействованным в оценивании работы на электронном 

носителе. При желании ученик может предоставить работу на бумаге. 

 

2. Организация творческих, исследовательских и практических работ ТМРГ 

2.1.  Приказом директора гимназии назначаются общий координатор и координаторы по 

классам. 

2.2. В сентябре все учителя представляют общему координатору свои темы творческих, 

исследовательских и практических работ (для 8-х и 11-х классов) с краткой аннотацией 

(расшифровкой) темы, а также указанием вида работы, максимального количества 

учащихся, которые могли бы заниматься этой темой. 

2.3. Список тем предлагается координаторам по классам, которые доводят 

непосредственно до учащихся 8-х и 11-х классов список предложенных тем.  



2.4. Учащийся может предложить свою тему. В этом случае учащийся обязан 

договориться с руководителем работы самостоятельно и известить об этом своего 

классного координатора. 

2.5. Окончательный выбор темы (из предложенных школой или выбранной 

самостоятельно) учащийся делает на последней неделе 1-ой четверти. 

2.6. В процессе написания/выполнения работы (ноябрь-март) руководители работ дают 

обратную связь общему координатору и классным координаторам с помощью э-

дневников. 

2.7. В указанный срок руководители работ передают работу своего учащегося, 

оформленную по Положению об оформлении исследовательских и практических работ 

ТМРГ, вместе со своим заключением. 

2.8. Положение об оформлении исследовательских и практических работ ТМРГ является 

неотъемлемой частью данного руководства (Приложение 1). 

2.9. Приказом директора гимназии назначаются рецензенты исследовательских работ, 

даты защит и представления работ, а также школьные комиссии по оценке работ. 

 

3.  Этапы исследовательской и практической деятельности 

 

3.1.   Представление тем общему координатору                                                       сентябрь 

 

3.2.  Окончательный выбор темы учащимися                                           конец первой 

четверти 

  

3.3.  Руководитель знакомит учащегося (группу учащихся) с макетом 

 (структурой) работы и Положением об оформлении работы.                        октябрь-ноябрь   

 

3.4. Руководитель предлагает учащемуся учебные материалы     

 на выбранную тему                                                                                            октябрь-ноябрь  

 

3.5. Учащийся вместе с руководителем делает выбор  аспектов,  

 на которых в рамках выбранной темы, надо сконцентрироваться.  

Формулируется цель и ставятся задачи.                                                           октябрь-ноябрь   

 

3.6. Учащийся вместе с руководителем составляет план деятельности         октябрь-ноябрь 

 по выполнению задач    

                                                                                       

3.7. Учащийся выполняет непосредственно исследование или  

практическое задание, информируя руководителя о продвижении работы в виде 

еженедельных отчётов (письменных или устных)/видеоотчётов (на электронную почту 

руководителя )                                                                                                      ноябрь - январь     

                                                                               



3.8. Учащийся анализирует полученные результаты и оформляет их, сотрудничая с 

руководителем                                                                                                             февраль 

 

3.9. Руководитель знакомится с результатами и по необходимости рекомендует  ученику 

внести корректировки                                                                                                 февраль                                                                          

 

3.10. На основе результатов учащийся и его руководитель формулируют 

следствия, обоснования результатов, выводы.                                                         февраль 

 

3.11. Учащийся оформляет работу на основании Положения об оформлении 

исследовательских и практических работ                                                              начало марта 

 

3.12. Предзащита: учащийся представляет промежуточный отчёт о проделанной работе (2-

3 мин.) в виде наглядной презентации (например, Power Point), указывая название работы, 

поставленные цели, используемые методы для достижения этих целей, а также 

предполагаемые результаты своей работы на открытую аудиторию (одноклассники, члены 

оценочной комиссии, родители, руководители работы, другие заинтересованные лица), 

получает рекомендации/уточнения, работает над ними.     

конец марта/начало апреля   

 

3.13. Руководитель знакомится с работой и вносит по необходимости 

 корректировки                                                                                                                  апрель 

 

3.14. Учащийся окончательно оформляет работу                                                          апрель 

 

3.15. Руководитель представляет Заключение о работе.                                               апрель 

 

3.16. Работа с Заключением передаётся общему координатору.                                 2-4 мая  

 

3.17. Защита и представление работ                                                                                май                                                                                                                                                                                                                                                                           

 

 4. Заключительные положения 

 

4.1. Мониторинг выполнения данного порядка осуществляет назначенный директором 

общий координатор и координаторы по классам или другое доверенное лицо, назначенное 

директором. 

 

    

 

 

 

 

 

 

 

 



ТРЕБОВАНИЯ К ИССЛЕДОВАТЕЛЬСКИМ РАБОТАМ УЧАЩИХСЯ ТМРГ 

 

Данные правила составлены соглано стандартам ISO (ISO 5966 – 1982 (E) Documentation – 

Presentation of scientific and technical reports и ISO 690-1987 (E) Documentation – 

Bibliographic references – Content, form and structure, а также на основе материалов курса 

Tаimi Dreier LISAKURSUS UURIMISTÖÖ ARVUTIL (TIIGRIHÜPPE SA). 

 

1.1 Общие требования  к исследовательским  работам: 

 Исследовательская работа  должна отражать опыт собственного исследования, 

анализ исторических источников – документальных, материальных, устных и др.; 

 Обязательно приводятся ссылки на источники; 

 Автор должен сформулировать проблему, цели и задачи, рабочую гипотезу своего 

исследования, описать методы и ход исследования, сделать выводы; 

 Печатные работы выполняются на стандартных листах формата А4 согласно 

правилам оформления печатных работ на компьютере;  

 Объём исследования 10-20 печатных страниц без приложений; 

 Работа печатается только на одной стороне листа; 

 Иллюстрациями могут быть фотографии, диаграммы, графики, рисунки, карты. 

При первом упоминании иллюстрации в тексте, ссылку дают в круглых скобках 

(рис. 8), при повторной ссылке добавляют сокращённо слово «смотри» (см. рис. 8); 

 Иллюстрации, взятые из других источников, подписывают со ссылкой на источник, 

откуда они взяты; 

 Фамилии лиц, изготовивших оригиналы иллюстраций, указываются в скобках 

(фото автора; фото Л. Петрова) 

 Сокращения и аббревиатуры не допускаются, за исключением общепринятых. 

1.2 Разделы работы следующие: 

 Титульный лист 

 Содержание 

 Введение 

 Главы работы  



 Заключение 

 Резюме на исследовательскую работу (пишется на языке, отличном от языка 

работы) (см. приложение 5)  

 Используемая литература 

 Приложения 

1.3 Титульный лист (см. приложение 1) 

На титульном листе следует указать: 

 название учебного заведения (выравнивание по центру); 

 номер класса (выравнивание по центру); 

 имя и фамилия автора (располагаются над заголовком, на высоте 2/3 листа, 

выравнивание по центру); 

 заголовок работы (bold, заглавными буквами, слова нельзя сокращать и 

использовать аббревиатуру, размер текста 20-22 pt, выравнивание по центру); 

 вид работы (указание типа) (реферат, работа по предмету, исследовательская 

работа, бизнес план и тд., выравнивание по центру); 

 руководитель работы (фамилия и имя, выравнивание справа); 

 место выполнения работы и год (запятой не отделяется, выравнивание по центру). 

1.4 Общие требования к оформлению: 

 Страницы нумеруются, начиная с титульного листа (номер на нём не ставится), 

номер печатается в нижнемем правом углу листа или в нижней части листа по 

центру. При нумерации учитываются все листы работы начиная с титульного 

листа, а также те, где располагаются таблицы и чертежи. Первый номер страницы 

располагается на втором листе содержания и нумеруется соответственно n+1 (все 

листы начиная с первого титульного заканчивая последним оформляются на 

компьютере).  

 Работа оформляется на белой бумаге с одной стороны листа формата А4 (210x297). 

При оформление работы используется стиль Normal: 

 шрифт Times New Roman 

 размер шрифта – 12 pt 

 выравнивание текста по обеим сторонам 

Format→Paragraph→General→Justify 



 межстрочный интервал – 1,5 Lines 

Format→Paragraph→Line Spascing→1,5 Lines 

 параметры страницы: 

слева/Left – 2,5 - 3 см, справа/Right – 2,5 см, снизу/Bottom и сверху/Top – 2,5 см 

File→Page Setup→Margins 

 отступы после абзаца 6 pt 

Format→Paragraph→Spacing: After 6pt 

 Названия всех глав (в том числе также предисловие, введение, заключение, 

используемая литература и резюме) пишутся заглавными буквами. Заголовки 

подглавы (подглава, подподглава и тд.) пишутся маленькими буквами (первая 

заглавная). В конце заголовка точка не ставится. Между заголовком главы и 

текстом оставляется, по крайней мере, одна пустая строка. Между заголовком и 

текстом минимум две пустые строки. 

 Главы работы и ее самостоятельные части (содержание, введение, заключение и 

тд.) начинаются всегда с нового листа. Подпункты продолжают лист.  

1.5 Оформление заголовков: 

 ЗАГОЛОВОК  ГЛАВЫ 1 УРОВНЯ 

 16pt, bold, все буквы заглавные 

 Подзаголовок главы 2 уровня 

 14pt, bold, наклонный шрифт, первая заглавная буква 

 Заголовок 3 уровня 

 13 pt, bold, первая заглавная буква 

Нумерация ставится не ко всем заголовкам. Нумерация отсутствует в пунктах: Введение, 

Заключение, Используемая литература, Приложения и т.д. 

1.6 Содержание: (см. приложение 2) 

В содержании представлены все главы соответствующие распределению и нумерации. 

Нумерация указывается (десятичная арабская нумерация, например 1.; 1.2.; 2.3.1. и тд.) 

только на главах содержания и их частях. Предисловие, введение, заключение, список 

используемой литературы, резюме и приложения не нумеруются, но учитываются в 

содержании. 



1.7 Оглавление: 

Оглавление создаётся автоматически на основе используемых стилей, что создаёт 

удобную навигацию по работе. В нём приводятся полные заглавия с номерами страниц.  

Оглавление работы создаётся в самый последний момент, когда работа полностью 

закончена. 

Insert→Reference→Index and Tables→Table of Contents 

1.8 Графические объекты: (см. приложение 3) 

 

Графические объекты включают в себя  диаграммы, графики, географические карты, 

чертежи, схемы или фото. Все работа, представленная таблицей/чертежами, нумеруется 

арабской нумерацией в рамках всей работы (простая нумерация) или отдельными 

заголовками (простая нумерация). Например “Таблица 1” или “Таблица 3.5”, "Чертёж 3.5", 

где последние цифры означают третья глава пятая таблица/чертёж. Если в работе только 

одна таблица/чертеж, то нумеровать ее не нужно. Номер таблицы и ее заголовок пишутся 

перед таблицей, номер чертежа и его название ставятся под чертежом. Если 

таблица/чертеж представлены на основе литературных данных, то обязательно приводятся 

ссылки на источники. 

Таблицу/схему необходимо расположить по возможности ближе к соответствующей части 

текста, к которой она относится. Можно использовать также ссылки по тексту 

(Следующая таблица 2 характеризует …) или дальние ссылки. В последнем случае ссылка 

заключается в скобках (смотри рисунок 4.1). Такая ссылка будет применима для 

таблицы/чертежа, которые будут располагаться на этой же или следующей странице. Все 

строки и столбцы в таблице должны имеет названия. Эти названия должны быть 

обязательно записаны в таблице с заглавной буквы. Заголовки подстолбцов и подрядов 

могут быть записаны с маленькой буквы. Данные равных единиц измерения 

располагаются в столбцах так, чтобы равные разряды стояли под им соответствующим. 

Размер текста в таблице используется 11pt и обязательно применяется выравнивание по 

высоте. 

1.9 Списки: 

Списки (Homeà Bullets and Numbering) обозначаются обычно арабскими номерами (1.; 2.; 

…), маленькими буквами ( a); b); …), скобкой и точкой. Список оформляется в 

соответствии с данным текстом, его длиной. Если в списке представлены отдельные 



слова, тогда они оформляются списком. Если в списке содержатся данные содержащие 

запятую или точку, то тогда для разделения данного списка используют отличительные 

знаки (маркеры). 

 Пример  

Производство материалов включает: 1) работу, 2) капитал, 3) землю. 

 Если в списке содержатся более длинные словосочетания или предложения, тогда 

каждый пункт начинается с новой строки.  

Пример  

Для развития туризма на островах необходимо: 

 быстрое и доступное транспортное сообщение с материком; 

 прямое сотрудничество с потенциальными рынками Латвии, Швеции и Финляндии; 

 сотрудничество между поставщиками услуг и государственными секторами; 

 разработка стратегии устойчивого развития туризма для каждого острова. 

1.10     Ссылки и список использованной литературы: 

 При составлении работы указываются ссылки на используемые работы других 

авторов, их основные наблюдения, цитаты из литературы и других источников, 

формулы, численные данные. Комментарии или данные других авторов в работе 

должны быть представлены в виде цитат или реферативного обзора. 

 Цитата должна полностью соответствовать оригиналу, как по словесному 

высказыванию, так и по пунктуации. автора с искажением слов. Цитата ставится в 

кавычки или выделяется курсивом, удаленные слова в продолжении мысли можно 

заменить точками (/ ... /). Ссылки на цитату устанавливаются сразу после закрытия 

кавычки, независимо от того, находится она в середине или в конце предложения. 

 Ссылки на текст оформляются так: в скобках приводятся фамилия  автора (без 

инициалов), год  публикации и номер страницы, то есть [Фамилия  Год: страница]  

         Пример  [Tamm 2010: 76] 

 Дословный текст из литературного источника: "Большие скорости течения 

способствовали развитию организмов низкой степени сапробности" [Иванов 1964: 16].  



 В ссылке на интернет - ресурс указывается также название страницы (при условии,   

что данный адрес доступный) и указывается число. 

Пример [Pärnu Ülejõe Gümnaasium. Stipendiumi statuut. 21.05.2011] 

 Внутри одной работы ссылки должны быть однотипными. 

 В список использованной литературы добавляются книги, периодических издания, 

веб-сайты и другие источники, которые используются при выполнении работ (не 

менее 8). Для каждого источника литературе должна быть ссылка на работу внутри.   

 В списке используемых источников очень важное место занимают все знаки: точки, 

запятые, двоеточие, пробелы и кавычки. Основательное и хорошее руководство 

Statistikaameti kodulehel (PDF fail) 

Правила и примеры 

Книга: 

Autori nimi, Initsiaal(id). (Aasta). Raamatu pealkiri kaldkirjas. Linn: kirjastuse nimi. (APA-

stiil) 

Lõugas, V. (1989). Arheoloogia Eestimaa teedel. Tallinn: Valgus. 

või 

Autor(id) (perekonnanimi koos initsiaalidega). Pealkiri. Kordustrükiandmed (väljaande 

number). Ilmumiskoht: kirjastus (väljaandja), ilmumisaasta, lehekülgede arv. 

Bleymüller, J., Gehlert, G., Gülicher, H. Statistik für Wirtschaftswissenschaftler. 8. Aufl., 

München: Vahlen, 1992, 241 lk. 

Сборник статей 

Autori nimi, Initsiaal(id). (Aasta). Artikli või peatüki pealkiri. Toimetaja eesnime 

initsiaal(id). Toimetaja perekonnanimi. (Toim), Kogumiku nimi kaldkirjas. Linn: kirjastuse 

nimi. (APA-stiil) 

Vapra, A. (1988). Vananemine ja eaka inimese tervishoid. H. Jänes (Toim), Tervise teejuht I. 

Tallinn: Valgus. 

või 



Artikli autor. Pealkiri. – Kogumiku nimetus. Ilmumiskoht: kirjastus (väljaandja), 

ilmumisaasta, kasutatud artikli leheküljenumbrid. 

Ivanova, N. Eesti pankade tegevuse uued põhisuunad. – Majandusteadus ja majandusharidus 

Eesti Vabariigis. Tartu: TÜ Kirjastus, 1995, lk 57–58. 

Статьи в журнале 

Autori nimi, Initsiaal(id). Aasta. Artikli pealkiri. Ajakirja nimi kaldkirjas, ajakirja number, 

lehekülgede numbrid, kus artikkel asub. (APA-stiil) 

Otsing, A. (1994). Pentium tootmises ja turul. Arvutimaailm, 3, 22-24. 

või 

Autor. Pealkiri. – Ajakirja nimetus, ilmumisaasta, ajakirja number, leheküljed. 

Parts, E. Välisinvesteeringud maailmamajanduses. – Eesti Välismajanduse Teataja, 1995, nr 

8, lk 56–59. 

Статьи на интернет - страницах 

Autori nimi, Initsiaal(id). (kuupäev – kui on olemas) Artikli pealkiri. Loetud: kuupäev. kuu 

aasta, lehelt URL-aadress. (APA-stiil) 

Nowakowsky, J. Constructivist Model for Learning. Loetud 25. oktoober 2008,  

http//www.ncrel.org/sdrs/areas/ issues/content/cntareas/science/sc5model.htm. 

või 

Autori nimi, initsiaal. Artikli pealkiri. URL-aadress (materjali täielik interneti aadress), 

materjali kasutamise kuupäev. Kui autorit ei ole võimalik kindlaks teha, tuleb näidata aadress 

koos kõigi kirjete ja materjali hankimise kuupäevaga. 

Laasik, L. Mõned näpunäited dokumendimalli kasutamisel, 

http://infutik.mtk.ut.ee/qpe/templaat/juhend.htm, 17.02.2003 



Pärnu Ülejõe Gümnaasiumi koduleht. Stipendiumi statuut, 

http://www.ylejoe.parnu.ee/index.php/koolikorraldus/dokumendid/98-stipendiumi-statuut  

(21.05.2011) 

 В списке использованой литературы сначала указывают источники на русском 

языке (в алфавитном порядке), затем – на иностраном, потом интернет – источники 

(см. приложение 4). 

1.11  Оформление практических и творческих работ 

При оформление данного вида работ рекомендовано исходит из целей и специфики 

ученических работ. Однако при оформлении и написании теоретической части работы 

всё же необходимо придерживаться общепринятых правил. 
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Приложение  1 

Таллиннская Мустамяэская реальная гимназия 
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Приложение 3 

 

 

 

 

 

 

 

 

 

Рис. 1. Линейный (1) и весовой рост (2) особей популяции Buccinum undatum L.  

 

 

 

 

Рис. 2. Этапы коммерциализации Интернета и формирования  

различных форм электронной коммерции (источник: http://www.hitechdimensions.com) 
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Таблица 1. Калорийность (ккал/г сырой массы) Limnodrillus hoffmeisteri Clap. в сточных водах 

фармацевтического производства  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Приложение 4 

 

 

 

 

 

 

 

 

 

 

 

 

 



Приложение 5 

Что такое резюме? 

Резюме должно быть на эстонском или иностранном языке.  

 Резюме (фр.) – краткий итог прочитанного, содержащий его оценку.  

Это небольшой по объему текст, характеризующий основные идеи исследования, 

делающий выводы, подводящий итоги. Обычно оно состоит из нескольких предельно 

кратких, четких и выразительных предложений, раскрывающих, по мнению автора, 

самую суть исследовательской работы.  

Резюме – это краткий перечень ключевых моментов всего исследования. Оно создает 

первое впечатление об авторе  

 Резюме можно назвать миниатюрной версией исследовательской работы. Оно не 

должно содержать более 3/4 страницы. Оно обычно включает пару важнейших мыслей 

из каждой основной части исследования. Обычно объем резюме от 150 до 200 слов.  

 При написании резюме авторам следует придерживаться следующей структуры: 

описание проблемы,  

подход,  

результаты и выводы 

 

 


